
WAAS RAIM/FDE PREDICTION PROGRAM INSTRUCTIONS
 NOTE:  The WFDE Prediction Program requires an internet connection.  This is to provide access to current almanac, 

GEO almanac, and configuration files.

 NOTE:  These instructions assume the user has experience operating the G1000 with GIA 63W, the GNS480, or the 
applicable GNS 400W/500W Series Unit and is familiar with the operation of RAIM and FDE.

FAULT DETECTION AND EXCLUSION (FDE)
The GARMIN G1000 with GIA 63W, the GNS480, and the GNS 400W/500W Series products incorporate Fault Detection 

and Exclusion (FDE) features, satisfying the requirements of TSO-C145a, TSO-C146a, and “GPS Oceanic/Remote Navigation” 
per FAA AC 20-138A Appendix 1.

FDE consists of two distinct parts: fault detection and fault exclusion.  Fault detection (RAIM) detects the presence 
of an unacceptably large pseudorange error (and presumably, position error) for a given mode of flight.  Fault detection 
is synonymous with RAIM (Receiver Autonomous Integrity Monitoring).  Upon the detection of a fault, fault exclusion 
follows and excludes the source of the unacceptably large pseudorange error, thereby allowing navigation to return to normal 
performance without an interruption in service.  FDE functionality is provided for oceanic, en route, terminal, and non-
precision approach phases of flight.  The FDE functionality adheres to the missed alert probability, false alert probability, and 
failed exclusion probability specified by TSO-C145a/146a.

The WFDE Prediction Program (006-A0154-01, 006-A0154-02, and 006-A0154-03) is designed for use with TSO-C145a/
TSO-C146a approved, WAAS-(Wide Area Augmentation System) certified Garmin products.  These products include:

• GPS 400W, GNC 420W, GNC 420AW, GNS 430W, GNS 430AW
• GPS 500W, GPS 500W TAWS, GNS 530W, GNS 530W TAWS, GNS 530AW, GNS 530AW TAWS
• GNS 480
• G1000 with GIA 63W

PRE-DEPARTURE VERIFICATION OF RAIM/FDE
A RAIM or FDE prediction must be performed prior to departure for the following types of flight plans:
• An FDE prediction is required for Oceanic/Remote operation where GPS is to be the primary source of navigation 

per FAA AC 20-138A Appendix 1.
• A RAIM prediction is required for all other flight operations in accordance with local aviation authority guidelines for 

TSO-C129a equipment, as required by an Aircraft Flight Manual limitation placed on Garmin G1000 with GIA 63W, 
GNS 480, and GNS 400W/500W Series products.  Examples of such operations include navigation of U.S. Area 
Navigation (RNAV) routes, Standard Instrument Departures (SIDs), or Standard Terminal Arrival Routes (STARs) per 
FAA AC 90-100 “U.S. Terminal and En Route Area Navigation (RNAV) Operations”.

• A WAAS satellite visibility prediction is required for all LVAV/VNAV or LPV approach as required by an Aircraft 
Flight Manual limitation placed on Garmin G1000 with GIA 63W, GNS 480, and GNS 400W/500W Series products.

Prior to departure, the operator must use the WFDE Prediction Program supplied with the applicable trainer or route 
planning software to demonstrate that there are no outages in the capability to navigate on the specified route of flight.  The 
WFDE Prediction Program determines whether the GPS constellation is robust enough to provide a navigation solution for 
the specified route of flight.
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RUNNING THE FDE PREDICTION PROGRAM
Trainer and route planning software for WAAS-certified Garmin products include a WFDE Prediction Program to meet 

the FDE requirements for GPS as a primary means of navigation for Oceanic/Remote operations (reference FAA AC 20-138A 
Appendix 1).  The Oceanic/Remote flight phase occurs when the flight plan will place the aircraft more than 200 nautical 
miles from the nearest airport.  All operators using a Garmin WAAS-certified unit as primary means of navigation in oceanic/
remote areas under FAR parts 91, 121, 125 and 135 must utilize the WFDE Prediction Program prior to conducting a flight 
in these areas.

Prior to navigation on U.S. RNAV routes, SIDs, and STARs (reference FAA AC 90-100) all operators of Garmin WAAS-
certified units must utilize the WFDE Prediction Program to determine RAIM availability.

All operators of Garmin WAAS-certified units should utilize the WFDE Prediction Program to determine WAAS satellite 
visibility when planning an LNAV/VNAV or LPV approach.

The detection function (of Fault Detection and Exclusion) refers to the ability to detect a satellite failure which can affect 
navigation.  The exclusion function refers to the ability to exclude one or more failed satellites and prevent them from affecting 
navigation.  The WFDE Prediction Program allows the pilot to specify the planned departure date/time, route type, ground 
speed, ground speed variation, and maximum allowable outage.  When provided through NOTAM or other sources, GPS 
satellites with known failures can be excluded through the program's setup function.

To use the WFDE Prediction Program, begin by entering the intended flight plan into the applicable trainer software 
(G1000 Trainer or GNS 400W/500W Trainer) or the Garmin Route Planning software for the GNS 480.  The WFDE Prediction 
Program uses this information to analyze satellite coverage along the intended route of flight.

 NOTE:  A flight plan must be created and activated (using the applicable Trainer or Route Planning software) prior 
to running the WFDE Prediction Program.  The WFDE Prediction Program only works with the currently active flight 
plan.  Follow the  software instructions to create and activate a flight plan.  Software and instructions are available 
via the Garmin website at www.garmin.com.

Running the WFDE Prediction Program:
1) Make sure the applicable Trainer or Route Planning software is running .  If using a Trainer program, make sure the 

simulated unit is on, and the desired flight plan is active.

2) If using a Trainer program, select the ‘Options’ menu (Figure 1) in the upper left corner, and select ‘WFDE Prediction 
Program’ (G1000 Trainer), or ‘Fde Prediction Program’ (GNS 400W/500W Trainer).  OR

3) If using the Garmin Route Planning Software, click on the ‘Start Prediction’ button after setting up the route (Figure 1).

Figure 1  Start Prediction Program Options

Program Name

Click to Start 
Prediction Program

 NOTE:  If the WFDE Prediction Program has not been used previously, or has not been run recently, a series of pop-
up messages (Figure 2) may precede the WFDE Prediction Program window.  Follow the on-screen instructions to 
download new data from the internet.  The download time is normally very short (nearly instantaneous), but may 
vary with internet connection.  See the ‘Updating/Changing the Almanac and Configuration Files’ section of this 
document for details.
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Figure 2  Possible Update Messages

4) The WFDE Prediction Program window appears (Figure 3) listing the flight plan waypoints, selected antenna, and the 
current date/time as the departure time.  It is important to verify that the displayed route is correct before proceeding 
with the prediction.  Reference Table 1, and verify the correct Garmin part number (006-A0154-0X) appears at the top 
of the screen.  If the part number is incorrect, see the ‘Configuration Files’ section of this document.

 
NOTE:  If the route of flight requires an alternate airport, multiple predictions may be required (one for the primary 
and one for the alternate) to verify RAIM and/or WAAS satellite visibility availability at the primary and the alternate 
approach.

Figure 3  WFDE Prediction Window

Garmin Part 
Number, Use to 
Verify Version of 

Program

Garmin Part Number Applicable Product
006-A0154-01 G1000 with GIA 63W
006-A0154-02 GNS 480
006-A0154-03 GNS 400W/500W

Table 1
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5) Make sure that the selected antenna matches the antenna installed on the aircraft that will fly the flight plan.  To 
change the selected antenna, click the down arrow next to the ‘Antenna’ field.  A pull-down list appears listing the 
available antennas.  If the correct antenna is not known, select ‘Most Conservative’ for the most restrictive mask angle 
of the antenna options.

Figure 4  Antenna Pull-down List

6) To change the departure date, click the down arrow next to the ‘Date (UTC)’ field.  A calendar window appears.  Click 
the left or right arrows to select a different month (if desired), then click the desired date.

7) To change the departure time, click the hours, minutes, or seconds fields next to the ‘Time (UTC)’ field.  Click the up or 
down arrows (or type in desired time) to change the displayed time.

8) To change the planned route type, average ground speed, ground speed variation, maximum allowed outage, flight 
duration, Selective Availability conditions, or to deselect satellites, click the ‘Setup’ button.  A setup window is displayed 
(Figure 5).  Click the field for the desired item, then enter the desired value.  Table 2 describes the Flight Setup Window 
options.

Flight Setup Window Options
Route Type Oceanic -For Oceanic/Remote only operations 

Enroute/Terminal - For all other operations
Maximum Allowed Outage 
(Time)

This field defaults to 5 minutes when Oceanic is the selected route type. 
This field is set to default and ‘greyed out’ (not selectable) when Enroute/Terminal is the selected 
route type.

Ground Speed (Avg) Enter expected average ground speed for flight
Ground Speed Variation The ground speed variation setting will vary with the selected route type, the default is 100 knots 

for Oceanic and 10 knots for Enroute/Terminal route types.  The program automatically runs 
multiple predictions for a range of ground speeds based on this setting.

Flight Duration This field is calculated from the entered ground speed and route information; or the flight duration 
can be entered, and the program will calculate the average ground speed.

Departure Date and Time Enter date and time (in UTC format) of departure, this info can also be entered into the main 
screen of this program.

Selective Availability Simulates Selective Availability conditions when box is checked (normally left unchecked).
De-select Satellites Click on the De-select Satellites button to view the Selected Satellites window, see following 

instructions.
Table 2

 
NOTE:  The maximum allowed outage time for Oceanic flights vary according to the specific route.  The pilot must 
determine the proper allowed outage time to be used for the prediction.
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Figure 5  Flight Setup Window

9) To deselect satellites from the setup window, click ‘De-select Satellites’, then clear the box adjacent to any satellite that 
should not be used in the prediction (Figure 6).  WAAS satellites are not listed in the Satellite Selection Window as RAIM 
and FDE availability are not predicated on the availability of WAAS satellites.  However, WAAS satellites are required 
to conduct LPV and LNAV/VNAV approaches.  Always check for NOTAMs regarding LPV and LNAV/VNAV outages 
(in addition to using the Prediction Program) to determine the availability of LPV and LNAV/VNAV approaches at the 
destination.

Figure 6  Selected Satellites Window

 NOTE:  Satellites that are unavailable will be ‘greyed-out’ with no check marks.  Satellites with ‘Poor Health’ will 
default to unchecked status.

Figure 7   Almanac Warning
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 NOTE:  To ensure accuracy of results, the almanac data used for the RAIM and FDE predictions must be recent.  
If the information is out of date, the WFDE Prediction Program will automatically prompt the user to update the 
almanac data (Figure 7).  An internet connection is required to use this feature (see following instructions).

10) To calculate RAIM, FDE availability, and WAAS satellite availability; select the ‘Calculate’ button from the main WFDE 
Prediction Program window (Figure 3).  A ‘Calculation is complete’ message will appear when the prediction is complete 
(Figure 8).

Figure 8  Calculation Complete Screen

11) The GPS/FDE Availability Results screen (Figure 9) appears after clicking the OK button on the ‘Calculation is 
complete’ message screen.  The results can be viewed or printed (see Printing section of this document) for later 
reference.

Figure 9  GPS/FDE Availability Results Screen
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Viewing the RAIM and FDE Prediction Results:
1) Select the View menu from the main WFDE Prediction Program window.  The results also appear automatically after 

clicking the OK button on the ‘Calculation is complete’ message screen.

2) Select Results.  A window will appear showing the calculation results (Figure 9).

3) To print the calculation results, see the Printing section in this document.



INTERPRETING THE FDE PREDICTION RESULTS
The GPS/FDE Availability Results screen provides either a ‘GO’ or ‘STOP’ status for the GPS, RAIM, FDE, LNAV RAIM, and 

LNAV/VNAV & LPV minima availability.  A yellow flag is a possible result for an FDE prediction for a non-Oceanic prediction.  
(see Figure 10)

A ‘GO’ status indicates that there are enough satellites available during the flight to meet the requirements of that category.
It is possible to have multiple FDE Availability outages during the flight and the status may still be a ‘GO’, as long as none of 
the outages exceeds the selected maximum allowable outage.

A ‘STOP’ status is the result of a predicted loss of satellite availability.  An FDE Availability or RAIM availability failure 
occurs when sufficient satellites are not available for a period longer than the maximum allowable outage (as selected in the 
Flight Setup page and viewed in the Setup Information box on the GPS/FDE Availability Results screen) and will produce a 
‘STOP’ status.

A yellow flag indicates an FDE outage in a non-Oceanic (Enroute/Terminal) type prediction.  Because FDE availability is 
not required for Enroute/Terminal operations the yellow flag is only a caution to the pilot indicating that there may be an FDE 
outage when flying the flight plan.  The selected flight plan may be flown despite the caution flag.  A ‘STOP’ status can appear 
in the FDE outage section only when an Oceanic prediction results in an FDE outage.

 Figure 10  Prediction Results Icons

More satellites are needed to provide FDE availability than are needed for RAIM.  More satellites are needed to provide 
RAIM availability than are needed for basic GPS availibilty.  A GPS Availability failure occurs when there is the loss of the 
ability to compute a position.  This is expected to be accompanied by a an FDE availability failure and a RAIM availability 
failure.  

• For Oceanic/Remote navigation predictions the displayed result should be ‘FDE is available for this route’.  In the 
event of a predicted outage, the flight should be delayed, canceled, or re-routed where FDE requirements can be 
met.

• For U.S. RNAV routes, SIDs, or STARs navigation predictions, the displayed result should be ‘RAIM is available for 
this route’.  In the event of a predicted outage, the flight should be delayed, canceled, or re-routed where RAIM 
requirements can be met.

• For LNAV approach at the arrival waypoint predictions, the displayed result should be ‘LNAV RAIM is available’.  
In the event that LNAV RAIM is not available, flight planning should include an approach that is not based on GPS 
navigation equipment.

• For LNAV/VNAV or LPV approach at the arrival waypoint predictions, the displayed result should be ‘LNAV/VNAV 
& LPV minima may be used for flight planning at the arrival waypoint for the estimated arrival time’.  In the event 
of an ‘LNAV/VNAV & LPV minima should not be used for flight planning at the arrival waypoint for the estimated 
arrival time’ result, flight planning should include an approach that has at least LNAV minima (if based on GPS 
navigation equipment) or an approach that is not based on GPS navigation equipment.

 
NOTE:  Since (due to unforeseen circumstances) actual departure times often differ from planned departure times, 
it is good practice to perform predictions for several possible departure times.
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Suggestions to change the result of a failed flight plan prediction:
1) Alter the departure date and time.

2) Alter the route of flight.

3) Verify any deselected satellites.  It is possible that some satellites unavailable for a previous prediction are now available.

4) Update the almanac, especially if it is more than three months old.

5) Use the correct antenna selection (if ‘Most Conservative’ was used).

6) For Oceanic/Remote operations, determine the actual maximum allowed outage and use for the prediction (instead of 
the 5 minute default setting which is generally shorter than the actual allowed outage time).

UPDATING/CHANGING ALMANAC AND CONFIGURATION FILES

ALMANAC, GEO ALMANAC, AND CONFIGURATION FILES
To ensure that each is current, the Almanac, GEO Almanac, and Configuration Files are automatically checked each time 

the program is started.  If the program finds any of these files to be out of date, it will automatically update the file via the 
internet.  A provision has been made to update these files manually, if needed.

Manually Updating the Almanac, GEO Almanac, and Configuration Files:
1) From the main WFDE Prediction Program window, select the Help menu (Figure 11).

Figure 11  Help Pull-down Menu

2) Select Update Almanac, Update GEO Almanac, or Update Configuration File.  The program automatically searches the 
internet and downloads the most recent data.

3) A pop-up window appears to confirm that the data has been downloaded.  Click the OK button to return to the WFDE 
Prediction Program.

4) The file has been updated.
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CHANGING THE CONFIGURATION FILE
The WFDE Prediction Program may be used with several different Garmin software programs.  Each program uses a 

specific configuration file to run the WFDE Prediction Program.  If the user has multiple Garmin programs loaded, the user 
must verify that the configuration file currently in use is correct for the Garmin product that will be used to navigate the flight 
plan.  Generally speaking, most users will not need to change the configuration file, although a provision has been made to 
update these files manually, if needed.

Changing the WFDE Configuration File:
1) From the main WFDE Prediction Program window, select the Help menu (Figure 11).

2) Select ‘Change WFDE Configuration File’.

3) A pop-up window appears.  Click the OK button to allow the program to download new configuration files via the 
internet.  When the configuration files have been downloaded, a ‘Configuration Select’ pop-up window appears.

4) Click the down arrow to view the pull-down list of available configuration files (Figure 12).  Select the file corresponding 
to the Garmin product that will be used to navigate the flight plan.

Figure 12  Configuration Select Window

5) Click the correct file name on the pull-down list, then click the OK button.

6) The configuration has been changed.  See Figure 3 and Table 1 to verify the correct part number appears on the WFDE 
Prediction Program window

PRINTING

PRINTING THE PREDICTION RESULTS
Use of the ‘Print’ selection on the ‘File’ menu (in the upper left-hand corner) is not recommended, as the complete results 

of the prediction are not included on the printout.  If a printout is desired, use the following steps.

Printing the Prediction Results:
1) From the GPS/FDE Availability Results screen (Figure 9), press ALT+PRINT SCREEN to make a copy of the image.

2) Using another program (such as MS Word®), open the file you want to paste the image into and use the ‘Paste’ 
command to paste the image into the file.

3) Print the file from the “other” program.

4) Repeat the preceding steps (if desired) from the Main WFDE Prediction Program screen (Figure 3) to record the 
Departure Time.
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